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CHAPTER 5

Developing the HEC-RAS Import File

The HEC-RAS Import File consists of geometric attribute data necessary
to perform hydraulic computations in HEC-RAS. The import file is
developed from an existing Digital Terrain Model (DTM) of the channel
and surrounding land surface. Geometric data are extracted from the
DTM by locating the points of intersection of the RAS Coverages with the
DTM. Currently, a triangulated irregular network (TIN) is the only
supported type of DTM.

RAS Coverages created by the user include coverages for the Main
Channel Invert, Main Channel Ban{aptional), Flow Pathgoptional),

and Cross Section Cut Lines. Data extracted from the DTM and RAS
Coverages form an import file which contains: river, reach, and station
identifiers; cross section cut lines; cross section surface lines; cross section
main channel bank stations; and downsteam reach lengths for the left
overbank, main channel, and right overbank.

At this time, channel and overbank roughness coefficients, hydraulic
structure data, and optional cross-section properties such as levees and
ineffective flow areas are not written to the import file.

Chapter 5 discusses the steps in developing the HEC-RAS Import File.
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Digital Terrain Model

HEC-GeoRAS requires an existing DTM from which the geometric data
will be extracted. Currently, a TIN representation must be used for the
DTM. The DTM must be representative of both the land surface of the
surrounding floodplain and channel bottom.

Developing a hydraulic model begins with an accurate geometric
description of the surrounding landform, especially the channel geometry.
Channel geometry will dominate flow in river systems; therefamgy,

DTMs describing channel geometry with a high resolution should be
considered to perform hydraulic analysis Further, RAS Coverages

should be created with thoughtful evaluation of the hydraulics as governed
by the terrain.

Creating a Contour Coverage
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Before creating a Contour Coverage, select the DTM using the browsing
button or right clicking over thBigital Terrain Modelfield and selecting
from the popup list. Create a Contour Coverage from the DTM by
selectingCreate Contour Coveragefrom theRASPrep menu on the

project manager. Enter the name of @mntour CoveragandContour
Interval in the form that appears (see Figure 5.1). The contouring interval
should be selected based on the definition of the DTM. Contouring
interval units are read from the DTM header and displayed below the
Contour Intervalfield.

It should only take a few minutes to create the Contour Coverage
depending on th€ontour Intervaland number of points in the DTM.

The Contour Coverage is used to establish the geographic limits for
creating new coverages and to visually aid the user in properly drawing
the RAS Coverages. The Contour Coverage is not used for data
extraction.
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= Create Contour Coverage from DTM

Enter the name of the Contour Coverage and contouring interval.

Digital Terrain Model: E:%\CAMERON\ARCRAS\WAILUPE\WALI TIH

Contour Coverage: |:|
Contour Interwval:

Units: FEET

Create Contour Cnveragel Ca.nc!ell Helpl

Figure 5.1Create contour coverage window

Creating and Editing RAS Coverages

Throughout this manual, the coverages used for extracting geometric
attribute data from the DTM are collectively referred to as RAS

Coverages. The RAS Coverages are created by drawing arcs (lines) which
represent the geometric data needed to create a HEC-RAS model. The
four RAS coverages are the Main Channel Invert, Main Channel Banks
(optional), Flow Pathgoptional), and Cross Section Cut Lines.

Creating and editing the RAS Coverages is accomplished in ARCEDIT
using the Edit RAS Coverages window. The editing environment is
accessed from the project menu by selec@irepte/Edit RAS Coverages
from theRASPrep menu. An editing window will appear to the right of
the Edit RAS Coverages window. The windows may be moved, and the
editing window may be sized to the users preference.

To import existing coverages, select them from the project manager before
accessing the coverage editing environment. The coveragbs w

imported into the editing environment as each coverage is selected for
editing.
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Coverage Editor
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The Edit RAS Coverages window is organized by function. A menu bar at
the top of the window provides access to the File and Help menus. The
upper portion of the window allows the user to select the type of coverage
to be edited and displays the entire pathname for the current edit coverage.
The middle portion of the edit window provides the user with tools for
editing the RAS Coverages. The bottom portion of the window allows the
user to display background coverages when editing a coverage. Editing
options are shown in Figure 5.2.

< Edit RAS Coverages _ O] %]

File Help
Edit: * Hone (" MC Invrt{ MC Banks{ FlowPath{ XS CutLn
Cov.:

Edit Tools:

Il ) ™ 1] IS ™ (G| A
ELECT ELECT eLect|  |umsmeer|  |umsmeen]  [umsmer HITCH ADARE
s I RS R RS B A I | N
HOVE COPY DELETE PLIT|  |UNZELIT FLIF | AREOHS

21| e 0
AOVEL AODY DELY | HRPPIHG| HDD

Display Coverages:

Il Current Edit Coverage [T Main Channel Invert

[T HMain Channel Banks [T Flow Paths
[ X85 Cut Lines [ Ground Contours
= =]

Refresh Display |

Figure 5.2Edit RAS Coverages window

Managing Coverages
Coverages are managed in the edit environment under the File menu, the
Edit type choices, and tt@ov. display field.

New, Open, Save, and Save As options are available from the File menu
option and cannot be used untkdit type is chosen. The Command Line
option and Exit are available under the File menu, as well.
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New: Creates a new coverage of thdit type selected. A message box

will allow the user to input the new coverage name. If the name conflicts
with an existing coverage, the user will be prompted to overwrite the
existing coverage. The coverage will be created in the default directory if
the entire pathname is not given.

Open: Opens an existing coverage. The coverage is opened as the current
Edit type.

Save:Saves the current edit coverage. Operations are also performed on
the edit coverage which create nodes at intersecting arcs. Dangling arcs
are created when an intersection is created and an arc overshoots the
intersecting node. Dangling arcs should be removed from the Main
Channel Invert Coverage.

Save As:Saves the current edit coverage with the new name entered. If
the name is in conflict with an existing coverage, the user will be prompted
to overwrite the existing coverage. The coverage will be saved in the
default directory if an entire pathname is not given.

Command Line: Allows the user to provide line commands at the
ARCEDIT prompt. Type &RETURN to return to the user interfatbis
option should only be used by experienced ARC/INFO users.

Exit: Quits from the editing environment and returns the user to the project
manager.

The Help menu allows the user to access online help using the Help and
ArcDoc options.

Help: Results in the display of a popup window with an ascii help file
specific to the editing window.

ArcDoc: Activates the ARC/INFO online help document.

Edit: Allows the user to select the RAS Coverage type to edit. If no
coverage has been entered in the corresponding text field on the project
manager, a new coverage of thdit type will be created. If the coverage
has been entered, it will be loaded as the current edit coverage and drawn
in the editing window at the full extent of the coverage.

Cov.: Displays the pathname of the current edit coverage.
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Edit Tools

The edit tools allow the user to create and edit the RAS Coverages using a
mouse. The edit coverage is displayed in black, while the currently
selected arcs are displayed in magenta. The following edit options are
available:

SELECT One: Selects one arc to be edited. Use the left mouse button to
select an arc. Select an arc before performing edits such as COPY,
DELETE, MOVE, etc ...

SELECT Many: Selects many arcs to be edited. Use the left mouse
button to select arc. When finished selecting arcs press, Ctrl + right mouse
button to exit.

SELECT All: Selects all the arcs in the edit coverage.

UNSELECT One: Unselects one arc. Use the left mouse button to
unselect an arc.

UNSELECT Many: Unselects many arcs. Use the left mouse button to
unselect arcs. When finished unselecting arcs press, Ctrl + right mouse
button to exit.

UNSELECT All: Unselects all the arcs in the edit coverage.

SWITCH: Switches the selection. Unselected arcs are selected as selected
arcs are unselected.

ADD ARC: Adds an arc. The right mouse button begins and ends an arc
by drawing a node. The left mouse button draws a vertex. An arc must be
composed of at least two nodes: a FROM node and a TO node. Press
Ctrl + right mouse button when finished. Arcs may contain no more than
500 points (498 vertices and 2 nodes).

MOVE : Moves the selected arc(s). Use the left mouse button to drag and
drop the selection.
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Copy

I[-]

DELETE

EDIT
NAHRE=

COPY: Copies the selected arc(s). The selection is copied parallel at the
position indicated by the cross-hairs by pressing the left mouse button.

DELETE: Deletes the selected arc(s).

SPLIT: Splits the selected arc into two arcs by placing a node at the
selected location.

UNSPLIT: Combines two arcs into one by removing a shared node. If this
option does not combine the arcs, zoom in and check that the nodes lie on
top of each other (share the same point). If the nodes do not share the
same point, use tHdOVEVertex option to snap the nodes to the same
point.

FLIP : Reverse the direction of the selected arc(s) by reversing the FROM
and TO nodes. Use tAdRROWS option to determine arc orientation.

ARROWS : Indicates the direction the arc was constructed by placing an
arrow in the direction of the TO node.

EDIT NAMES : Edits the river and reach name of the selected arc. River
reaches ll be labeled and cross-hairs will appear to allow the user to

select the reach to edit. The window shown in Figure 5.3 appears, after
selecting a river reach. River and reach names must be 16 characters long
or less. Reach names on the same river must be uniqué? briEn

provides a list of previously used river names which may be sele®t€d.
accepts the entered names, dismisses the window, and saves the edit
coverage.Canceldismisses the window without changing the names.
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% Name Stream Network _ (O] x|

Enter River and Beach Hames for the selected reach.

Current Coverage: e:}cameronlarcras\wailupelwai str

River Hame {Stream ID}: |Hailu1:-e | ? |
Reach Hame (Reach ID): |UFPEI |
(1) 4 | Cancel | Help |

Figure 5.3 Stream network editing window

MOVEVertex: Moves a vertex on the selected arc. Select a vertex by
placing the cross-hairs over a vertex and pressing the left mouse button.
Move the cross-hairs to the new location and press the left mouse button a
second time. The cross-hairs will remain on the editing window allowing
the user to continue to move vertices. If trouble is encountered, zoom in
on the vertex so that the exact location of the vertex may more easily be
selected. Press the right mouse button when finished moving vertices.

ADDVertex: Adds a vertex to the selected arc. Place the cross-hairs over
the location to add a vertex and press the left mouse button. Cross-hairs
will remain allowing the user to continue to add vertices. Press the right
mouse button when finished adding vertices.

DELETEVertex: Deletes a vertex from the selected arc. Place the cross-
hairs over the vertex and press the left mouse button. This option will also
delete a node making the vertex on the end the new node. However, if an
node is on top of a vertex the user must delete both the node and vertex.
Cross-hairs will remain, allowing the user to continue to delete vertices.
Press the right mouse button when finished deleting vertices.

SNAPPING: Sets the node snap environment. This option will invoke the
node snap environment window shown in Figure 5.4. The snapping
tolerance determines the distance between nodes before they will snap
when drawingnewarcs (or moving nodes and arcs) and is shown in the
units taken from the DTM header. T#ebutton allows the user to set the
snapping tolerance visually in the editing window. Node snapping may be
turned on or off. The default is ON with the snapping tolerance set to
1/1,000 of the width or height, whichever is greatest, of the current edit
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m

coverage. Pres3K to dismiss the window with the current node snap
environment.

% Node Snap Environment _ (O] x|

Snapping Tolerance: 19.72999 {* OH{" OFF

Units: FEET
[1]:4 |

Figure 5.4Node Snap Environment window

The node snhap tolerance will determine the minimum allowable distance
between two nodes. When a coverage is saved, any vertices or nodes that
are separated by less than the snap tolerance will snap together, altering the
construction of the corresponding arc.

UNDO: Undoes the last edit. Undo keeps track of the edits since the
coverage was last saved. Undo will not work with the EDIT NAMES
option.

Display Coverages

To aid the user in creating and editing the Edit Coverage, coverages may
be displayed in the background of the editing window by selecting the
corresponding checkbox. The empty input field allows the user to select a
background coverage other than the Contour Coverage and RAS
Coverages. At this time, the background coverage must be a line
coverage. Each coverage is displayed in a unique color as summarized
below.

Coverage Color
Current Edit Coverage Black
Main Channel Invert Blue
Bank Stations Red
XS Cut Lines Green
Overbank Flow Paths Blue
Ground Contours Grey

5-9



Chapter 5 Developing the HEC-RAS Import File

Editing Window
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Coverage Color

Background Coverage Orange

Refresh Display Redraws the editing window, displaying the coverages
corresponding to the depressed checkboxes. Maintains the current extent
and position of the of the editing window.

There are several options available from the Pan/Zoom menu on the editing
window, shown in Figure 5.5 will be displayed. The pan and zoom options
may be used in the middle of a editing operation such as ADD ARC. After
execution of a menu option the editing window will be redrawn. The
Pan/Zoom menu options are described below:

Ean/Zoom
Create CHel+we
Ean Cirl+a
Zoom In Crl+
Zoorm out Chrl+x

Zoom In Center  Chrl+i
Zoom Out Center  Citl+o

Extent Cirl+e
Get Extent Ctrl+g
Fullvigw Ctrl+f
acale 1:1 Ctrl+t
Eedisplay Crl+r

Figure 5.5Pan/Zoom menu options

Create: Creates another window using the extent provided by the user.
Use the left mouse button to select opposite corners of the extent to be
created.

Pan: Pans the view in the direction of the mouse. Use the left mouse
button to pan.

Zoom In: Zooms in at the location of the mouse. Use the left mouse
button to zoom.
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Zoom out. Zooms out at the location of the mouse. Use the left mouse
button to zoom.

Zoom In Center. Zooms in to the center of the window by a factor of 2.

Zoom Out Center. Zooms out of the center of the window by a factor of
2.

Extent: Allows the user to specify the window extent (area to zoom into).
Use the cross-hairs and left mouse button to select opposite corners of the
extent to be viewed.

Get Extent. Prints the window extent to the ARCEDIT prompt.
Fullview: Displays the entire extent defined by the Contour Coverage.
Scale 1:1 Displays the window contents at a 1 to 1 scale.

Redisplay. Redraws the editing display window.

The geospatial position of the cursor is also shown at the bottom of the
editing window in Windows NT and at the top on UNIX systems. The
change in distance in the vertical direction and horizontal direction is
shown along with the total distance the cursor has moved from a specified
origin. To select a specified origin, select the location with the mouse and
press the left or right mouse button. The cursor position statistics
displayed on the ARCPLOT window are turned on and off using the
ARCWINDOWSTATS environment variable.

Main Channel Invert Coverage

The river and reach network is represented by the Main Channel Invert
Coverage. The network is created on a reach by reach basis, starting from
the upstream end and working downstream following the channel thalweg.
Construct arcs with the TO node downstream of the FROM node (in the
direction of flow) as done in HEC-RAS. Each reach is identified by a

River Nameand aReach NameA river is made up of one or more reaches
with the same River Name. All reaches within a river must have unique
Reach Names. Refer to the HEC-RAS User’s Manual, Chapter 6 for more
details.
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Creating the Network
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Begin by selecting thBIC Invert choice from the Edit RAS Coverages
window. In the response window, enter the name of the coverage to create
and pres©K. The name of the coverage may be no longer than 13
characters. The blank coverage will be set as the coverage to edit.

Each reach is represented by an arc. To draw a reach, préé3dhe

ARC button from the edit palette. Place the mouse cursor at the upstream

end of the reach and press the right mouse button to “drop” a node. Draw

the reach downstream stream using the left mouse button to create vertices
along the channel. At the end of the reach, press the right mouse button to
create the end node. After the end node is placed, a windcappear

to enter thRiver NameandReach Name The river and reach names may

be 16 characters or less. Théutton may be used to seledRaver Name

used previously in the Main Channel Invert Coverage. ZTbetton will
only list the river names since the last save.

To begin a connected reach, press the right mouse button to create a new
node and begin to draw the reach downstream. A junction is formed when
two or more nodes are placed one on top of another. A least one of the
nodes must be the FROM node on the downstream reach. Each reach may
be constructed with no more than 500 points.

It is recommended that the node snap tolerance be set by the user before
creating the stream network. Greater snap tolerances ensure that reaches
are connected at junctions; however, snap tolerance that are too large will
create problems with nodes snapping to the wrong junction nodes. Each
time that a coverage is Saved, nodes and vertices that are separated by less
than the node snap tolerance will be combined, thereby moving the
delineation of the main channel. If this problem occurs, reduce the node
shap tolerance.

Editing the river and reach network is accomplished using the editing tools
described earlier. The EDIT NAMES option should be used to check that
theRiver NamesandReach Nameare correctly named and that all reach
names within a river are unique.

Be sure to seledC Invert from theEdit choice on the Edit RAS
Coverages window to indicate that the edit coverage is the Main Channel
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Invert Coverage. If anoth&dit choice is selected, thi®iver Nameand
Reach Nameannot be edited.

The Main Channel Invert Coverage is shown in Figure 5.6. Ground
Contours displayed in the background, clearly delineate the main channel.
(Note that the “V” of the contours points in the upstream direction.)
Reaches are separated by nodes, displayed in ARCEDIT as black squares.

# ARCEDIT

Pan/Zoom

X:581587.56250 Y:47064.48828 dx:-808.37500 dy:
Figure 5.6 Main Channel Invert Coverage

Adding Reaches to an Existing Network

Adding a new reach to an existing river and reach network requires that a
reach be split. To split a reach, select the reach and chodSELihe arc
option from theEdit Toolpalette. Cross-hairs will appear for the user to
select the location to break the reach. Press the left mouse button when
the location is selected. The user will then be prompted to ediédbhb r
names of the two reaches and the selection cross-hhmppear over the
editing window. Select the first reach and edit or accepRéah Name

and pres©K. Use the cross-hairs to select the second reach and edit or
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accept thd&Reach Name PressingCancelwill keep the current names, as
will pressingOK without making any edits.

Adding Tributaries to an Existing Network

After a reach is split, add a new reach usingAb® ARC option. Enter
theRiver NameandReach Namat the window prompt. To check that

the node of the new reach lies on top the node of the downstream reach,
zoom into the junction. If the nodes are not aligned, the nodes can be
shapped together by moving the new reach or moving the end node of the
new reach. The latter is suggested. Select the new reach and choose the
MOVEV (move vertex) button from the editing palette. Select the TO
node with the cross-hairs and press the left mouse button. Select the
FROM node of the downstream reach and press the left mouse button.
Note that if the snapping tolerance had been greater than the separation of
the nodes, the nodes would have snapped on top of each other as the new
reach was created.

Merge Reaches in an Existing Network

To merge two reaches into a single reach, they must share a node. In other
words, the downstream node of the upstream river (TO node) must

coincide with the upstream node (FROM node) of the downstream river.

To verify that two nodes are coincident, zoom into the nodes’ location and
move one of the nodes on top of the other while the SNAPPING option is
ON.

Select the two reaches to be joined and choosEN&PLIT option from
the Edit Toolspalette. One reachilikbe drawn to the screen (only two
nodes, instead of three) and the Name Stream Network window will
appear. Enter the name of the newly formed reach and €#ect
PressingCancelwill keep the names displayed.

Main Channel Banks Coverage

The Main Channel Banks Coverage is a line coverage which indicates the
separation between the main channel and the overbanks and is used to
determine the main channel bank stations on the cross seclio@dVain
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Channel Banks Coverage is optiondlo indicate bank positioning, use
the ADD ARC option from theEdit Toolpalette and draw the position of
the bank stations fdyoth sidef eachriver.

The bank lines may be broken and may cross where tributaries join a river
reach. If two parallel bank lines are indicated (i.e., two broken bank lines
overlap), the bank stationing farthest from the river will be used.
Orientation of the bank station lines is not important. The Main Channel
Banks Coverage is shown in Figure 5.7, along with the main channel.

# ARCEDIT

Pan/Zoom

X:582406.25000 Y:47174.28516 dx:-632.87500 dy:
Figure 5.7Main Channel Banks Coverage

Flow Paths Coverage

The Flow Paths Coverage is used to determined the downstream reach
lengths between cross sections in the left overbank, main channel, and right
overbank. The Flow Paths Coverage is optional.
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The coverage is created by using #i2D ARC option to draw the

hydraulic flow paths in the left overbank, main channel, and right overbank.
If the Main Channel Invert Coverage already exists, the main channel flow
path will be copied into the Overbank Flow Path Coverage and, therefore,
will not need to be created. The three flow paths lines should not cross,
cross each cross section cut line exactly once, and be drawn in the direction
of flow (i.e., the TO node downstream of the FROM node). The Overbank
Flow Path Coverage is shown in Figure 5.8.

& ARCEDIT
Pan/Zoom

iy s

X:582133.56250 Y:47058.72656 dx:-822.56250 dy
Figure 5.8 Over Bank Flow Path Coverage

Cross Section Cut Lines Coverage
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The location, position, and expanse of channel cross sections is represented
by the Cross Section Cut Lines Coverage. The cross section cut lines are
used to extract the station and elevation data from the digital terrain model.

To draw a cross section cut line chooseAb® ARC option from the
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editing pallete. Press the right mouse button to place the FROM node and
draw the cut line to the TO node. Press the right mouse button to end the
cut line. Cross section cut lines are constructed with the FROM node at
the edge of the left overbank to the TO node at the edge of the right
overbank. Vertices may be placed between the FROM and TO node using
the left mouse button so that the cut line may be dog-legged perpendicular
to the direction of flow. A cut line should cross a reach line exactly once,
and should not cross another cut line.

The orientation of cut lines may be checked usingARROWS option on
the Edit Toolspalette. When pressed, the ARROWS option places an
arrow at the TO node pointing in the direction the arc was created. The
Cross Section Cut Line Coverage is shown in Figure 5.9 with the
ARROWS option turned on. If the cut line was constructed in the
incorrect direction, use tHeLIP option to reverse the FROM and TO
node. The FLIP option may be used on one or many arcs.

# ARCEDIT

Pan/Zoom

X:582098.93750 Y:47470.64063 dx:2.68750 dy:0.0
Figure 5.9Cross Section Cut Line Coverage
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Creating the HEC-RAS Import File
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To create the HEC-RAS Import File, sel€reate RAS Import File from

the RASPrep menu on the project manager. This will invoke a window
with input fields for the four RAS Coverages as shown in Figure 5.10. The
user must have specified the Digital Terrain Model, a Main Channel Invert
Coverage, and a Cross Section Cut Line Coverage from the project
manager before attempting to create the import file. The input fields for
the Main Channel Bank Stations Coverage and Overbank Flow Paths
Coverage may be left blank.

% Create RAS Import File (O] =]
Digital Terrain Model: E:\CM[ERUH“RCRAS\WAILUPE\WRI_TIH

RIVER AHD REACH HETWORK

Main Channel Invert: e:\cameron\arcrasiwailupe\wai_str

CROSS-SECTIOH DATA

X5 Cut Lines: e:\cameron\arcras\wailupelwai xs
Sampling Interval:  Triangle Edges { Select Interval FEET
Main Channel Banks: e:\cameron\arcras‘\wailupelwai hanks
Overbank Flow Paths: e:\cameron\arcras‘\wailupe\wai flow
HEC-RAS Import Filename: “ ‘
Create Import File | Ca.m:!ell Helpl

Figure 5.10Create RAS Import File window

Select the sampling interval method. The sampling method indicates where
the station and elevation data for cross sections will occur. The default
method Triangle Edgessamples the land-surface elevation at the edge of
each triangle in the TIN. Choosisglect Intervahllows the user to

specify a uniform distance between cross-section stations. The units used
for the sampling are read from the DTM.

Enter the filename for the import file. The extensigeo will be added to
the flename. The user is not allowed to change the extension. Press
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Create Import File when finished.Canceldismisses the window and

returns the user to the project manager.

Once theCreate Import File button is pressed, the attributes of the RAS
Coverages will be checked for missing data. Progrpdates \ll be
displayed in the Create RAS Import File status window shown in Figure

5.11.

= RAS Coverage Status

Coverage attributes will bhe checked
hefore creating the BAS Import File.

RIVER AND REACH HETWORE ATTRIEUTES
Rirver Hame
Reach Hame

Route Syztem

CUT LINE COVERAGE ATTRIBUTES
X5 Sationing
Bank Stations

Beach Lengths

RAS IMPORT FILE

=] B

STATUS

1) 4
1) 4

Checking

Hot Checked
Hot Checked

Hot Checked

Hot Written

Figure 5.11 RAS Coverage Status window

Coverage Checking

Before the RAS Import File is created, the RAS Coverages will be
checked. As the coverages are checked, geometric attribute data will be
added or updated to the Cross Section Cut Line Coverage. The window
shown in Figure 5.11 wilipdate to indicate the progress of the coverage

checking procedures. The status messages that are updated to the window

and their meaning are listed below. If any of the coverages were not
correctly created by the user, the checking procedure will be stopped and
the user informed of the missing coverage data.
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Message Meaning

Not Checked The corresponding attribute has not been
checked.

Checking The corresponding attribute is being
checked.

OK The coverage attribute was checked and
the appropriate coverage data is present.

Updating The attribute data is being updated.

Unmodified The coverage attributes present were not
updated since last attempt to create a RAS
Import File.

No Stations The Main Channel Banks Coverage is not
present.

No Reaches The Overbank Flow Paths Coverage is not
present.

Not Written The RAS Import File has not been written.

Writing The RAS Import File is being written.

River and Reach Network Attributes

The river and reach network attributes are checked first. The checking
procedure looks to see that the Main Channel Invert CoverageRiasra
andReach Naméor each reach in the coverage. Specifically, the checking
procedure looks to see that the arc attribute table (AAT) for the Main
Channel Invert Coverage contains the stream and reach items and that the
items are not blank. STR_NAME and RCH_NAME are the default name
created when the Main Channel Invert Coverage is create in the edit
environment.Reach uniqueness is not checkbérefore, it is

recommended that the user check the reach names prior to attempting to
create the RAS Import File. If tieiverandReach Nameare not present,
the checking procedure will be aborted and the user will be informed to
edit the invert coverage river and reach names.

Cross section stationing is determined by dynamic segmentation of the
Main Channel Invert Coverage. If this Route System is not present,
windows will direct the user to create one based on the lengths of the river
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arcs. Two ARC/INFO tables are created named as the Main Channel
Invert Coverage name followed by .SECHECSTR and .RATHECSTR. If
the Route System is already present, the user will be given the choice to
update the tables.

Cut Line Coverage Attributes

After the river and reach network attributes are checked, items are added
to the Cross Section Cut Line Coverage without user input. The user will
only be prompted to update the tables, if the geometric attribute data are
already present.

Cross section stationing data are added to the STATION item. If the
STATION item does not exist, it will be added.

Bank station data are contained by the items BANK1 and BANK2 (left and
right, respectively). Bank Stations will not be added if the Main Channel
Banks Coverage has not been specified. BANK1 and BANK2 are optional
items.

Reach length data are contained by RL1, RL2, RL3 (left bank, main
channel, and right overbank, respectively). Reach lengtihsoivbe added

if the Flow Paths Coverage has not been specified. RL1, RL2, and RL3 are
optional items.
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